
This guide is intended to help you install the
Distributed Network version of FastLook.
Please refer to the electronic help file for more
details on the operation of FastLook.

1

Contents

Overview ................................................................2

License manager Installation ..................................2

Configure License Manager ....................................3

Client Installation …………......................................8

FastLook Features ................................................10



2

Overview
The FastLook Distributed Network has two components: the FastLook
License Manager (FLM) and the FastLook viewer (Client). In operation,
the FastLook viewer will be running from the local machine, while
retrieving its license from the FLM located on a server.
The way the software works is: 1) the user runs FastLook on his machine.
2) FastLook will look to the server for a license. 3) Once it gets its license
the FastLook interface appears.
Note: If there is no license available, the user will get a notice so stating
and will be asked to try again later.
When user shuts down, FastLook communicates with the FLM and
releases the license for future use.

License Manager Installation

The FastLook License Manager (FLM) must be installed directly on a
Windows server and will operate as a service. You will need an IP
Address and port available on this server that is accessible by the client
users.

1. Insert the disk into the CD/DVD drive of the server.
2. The Setup screen will appear automatically if you have the
AutoRun feature enabled. If the Setup screen does not appear, run
the SETUP.EXE located in the root of the CD-ROM.
3. Follow the on-screen instructions to begin install.
4. Read the License Agreement, check "I agree" and press the Next
button.
5. Please specify the folder in which the FastLook program files will
be copied by the installation program. Setup will create the following
folder under the main FASTLOOK folder:
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FASTLOOK\EXE - The FASTLOOK\EXE folder will contain all of the
program files.
6. Choose a group to use to store the FastLook icons or accept the
default group.
7. Click Finish to install.
8. When the install is complete, you will be given the option to launch
the FastLook Distributed Network Monitor to configure the FastLook
License Manager.
9. Once you have completed the configuration of the FLM, you need
to go to your services monitor and start the FastLook Distributed
Network service. This service is set for an automatic start on all
future reboots of your server.

Configure FastLook License Manager

As previously stated, once the installation is completed on the server you
will be prompted to run the FastLook Distributed Network Monitor
program to configure the FLM. For future use, you will have a shortcut on
the server to run the Monitor (FLMON.EXE). The default username is
Admin and password is supervisor.
To access the Configuration Dialog, run the monitor and select the
Configuration command under the File Menu. A description of each tab
continues below.
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Communication Tab

IP Address and TCP Port

Select the IP and port you wish the FLM to use for communication.
This will need to be a unique combination for this computer, as no
two services can bind to the same combination.
Keep Alive Time

Set the Keep Alive Time, which defaults to 10 minutes. This time is
used both as the amount of time a client will run after losing
connection to the license manager, and as the amount of time the
server will tie up a license when it fails to receive communication
from the client.

Users Tab
You have the option of allowing open access to the FLM or forcing a login.
In the case of open access, anyone using FastLook will have all rights.
Forcing a login affords the ability to assign username and password
protection to the FLM, in addition to the ability to specify rights to each of
the users, i.e. printing, redlining, etc.

Always Prompt for Login
This option will present the user with a Login screen when FastLook
is run. FastLook will use the User Name, Password and Rights
established in Edit User Configuration. Disabling this option will
allow full access to all users.
Allows Users to Change Password
This option will allow users to change their own password. When
enabled, a menu item called Change Password will appear under
the File menu in FastLook.
To Add Users
Press the Add button to add a new user. Enter the User Name and
Password. You may now assign rights to the new user. Press Save
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Changes when you are finished assigning rights to this user. To
cancel the changes you have just made, press Cancel and Restore.
The User information is stored in a database named
FASTUSE.DBF, located in the FASTLOOK\EXE directory.
Allow Guest Login
This option will allow any user to sign in as a Guest User
automatically. When someone attempts to login, and this option is
checked, they may sign in as Guest. You may assign rights to the
Guest User. The Guest User may not be assigned a password and
may not be deleted from the database.
Assigning Rights
Rights may be assigned by choosing a predefined group or
selecting a custom set of rights. You may change rights for a user
by accessing the desired User Name and changing the rights in the
Rights section. To select a predefined group, click the left mouse
button on the desired group title. If a predefined group does not
represent the rights you wish a specific user to have, you may select
a custom set of rights. A check next to a right denotes that this right
is enabled for this user. Clear Rights will clear all rights for the
individual user specified in User Name. Be sure to Save Changes.

Predefined Groups
Administrator Privileges - All rights are assigned, along with
the right to add and delete users from the database.
Full Access - All right are assigned, except for the right to
add and delete users from the database.
View + Edit Link/Redline - Rights include Screen Config,
Printing, Exporting, Launch, View Redline, Create/Edit
Redline, View Link and Create/Edit link.
View Only - Rights include the same as above, except for
Create/ Edit Redline and Create/Edit Link.
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Print Options Tab
Stamp Printout with Redline Warning
FastLook may be configured to print a Warning if a Redlining or
Linking file exists for the particular drawing or image to be printed.
You may elect to print the current date, time, filename, user name,
specified text or any combination of these for the warning. These
combinations may be printed in any one of six locations on the page.
To create a Stamp
1. Check the Enable checkbox.
2. Select a "Position on Printout" from the dropdown such as "Upper
Left".
3. The font may be set for each position by selecting the Choose
Font button.
4. Type any text you wish to print in the Redline Warning edit box.
You may wish to include one of the stamping variables in the text
string. To do so, simply press the Insert Stamping Variables button
and choose the desired variable. A variable may appear in any
position in the text string.
Text Stamping
FastLook may also be configured to print a Text Stamp on most
drawing formats. The Text Stamp is created in the same manner as
the Warning as described above. A Stamp may be printed in each of
six positions independently. If the Warning is enabled, the position
defined for the Warning will not be available. A Global Print Stamp
defined in this section will take precedence over any Print Stamp the
user has defined locally.
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Global Settings Tab
These will be global settings affecting all users. In many instances it may
be desirable to limit ALL user access to various functions, i.e. printing,
redlining, etc. Checking or unchecking one of these settings will cause all
users to gain or lose this functionality, regardless if you have assigned
rights to individual users in the Users Tab.

Setting Corresponding FastLook Command
Copy Files File/Copy
Rename Files File/Rename
Delete Files File/Delete
Allow View Menu File/View and File/Open
Export File/Export
Launch Programs File/Launch
Email File/Send Mail
Print File/Print
Set Redline Preferences Redline Edit/File Preferences
Redlining Redline/View Redlining
Linking Links/View Links
Change Configuration Options/Options
Use Automatic Program Updates Feature - This option is available to
allow the FLM to automatically update the FastLook client viewer. Any
updates you place in the EXE folder of the Server installation will cause
the user to be prompted the next time the FastLook client is run that
updates are available. If he elects to update, these new files will be
downloaded and the user will be told that he will be updated the next
time he starts FastLook.
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Client Installation
The FastLook viewer software must be installed on each client computer.
If you wish to provide each new user installation with your own
configuration, i.e. toolbars, font path, etc., read the section named
Creating User Settings Template. If you simply wish to install the
FastLook viewer with factory default settings skip this next section.
Creating User Settings Template
FastLook provides the user with many configurable options. If you elect
to change the default options, these changes are saved on the client
computer in the system registry.
If you wish to customize any of the user configurable options for your
network users, follow these steps.

1. You must first install the FastLook viewer software on a client
machine by following the instructions in the section entitled
Installing Client Software.

2. After installing the FastLook viewer, run the program and make
your setting changes.

3. Press the Save Options command under the Options Menu to
save these settings.

4. In the Options dialog, found under the Options menu, select the
General tab and scroll to the bottom.  Press the “Create User
Settings Template” button which will create a FLUSER.INI
template file in the folder you choose.

5. Next, copy the FLUSER.INI file into the FastLook/EXE folder
located ON THE SERVER.

This will cause the User Setup to automatically use the settings contained
in this INI file as the default template for setting program options for all
subsequent client user installations.
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Installing Client Software
The FastLook viewer software may be installed in one of two ways
depending on the type of connection the client has to the server.
In either case, the USER32.EXE (32-bit) or USER64.EXE (64-bit) will
install all the FastLook files to the client machine and set up the shortcut
to run FastLook. If you have created a User Settings Template
(FLUSER.INI), the User Setup will use it to set user options. This is a way
for you to give the user a set of starting settings that you have chosen,
rather than the user starting with defaults.

LAN Access
If the client user has access through the LAN to the FastLook
folder on the server, he may run the USER32.EXE (32-bit), or
USER64.EXE (64-bit), setup program directly. The first time a
client runs, he will be prompted to provide the IP/Port combination
for the license manager. The only time a prompt will ever reoccur
for that user will be if the client cannot find the server on start up.
No LAN Access
If the client does not have LAN access, you will need to provide
the program files, either through ftp, email or CD. Use the User
Deployment Tool to create a self-extracting EXE, which your users
may use to setup the FastLook Distributed Network Client.
The User Deployment Tool is found in the FastLook/EXE folder on
the server. The filename is CreateDistUserSetup.EXE.
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FastLook Features
The following is a very brief outline of some of the features found in
FastLook. For more information pertaining to the operation of FastLook,
please refer to the Help file.
Configuration
We have gone to great lengths to provide you with the ability to
reconfigure FastLook to suit your needs. Many options, such as scroll
bars, background color, color themes, toolbar options and more, may be
configured in the Options Dialog under the Options menu. Use the Save
Options command if you would like to save the current configuration for
future sessions of FastLook.
Finding a File
The Navigation Panel is a collection of tools to help you find and
manipulate files. When FastLook is first run, the Panel may be displayed
in its closed state. Simply move the cursor over one of the tabs on the left
side of the drawing window to cause the Navigation Panel to slide out for
use. When a file is found, the Navigation Panel is used to easily pick the
file or files to view, print, email, etc. The Navigation Panel may be placed
into one of a number of modes. You may switch between these modes
easily by accessing the Tabs.

Files Tab
In the Files Tab the Navigation Panel consists of the tools
necessary to navigate your drives and folders to easily find files.
Last Viewed Tab
This tab will display all of the files you have viewed in the current
session. Hold the cursor over the filename to display the entire path.
Exiting FastLook will clear the filenames from the list.
Groups Tab
The lower list box will present the SmartGroups that have been
created. When you click on a SmartGroup, the file references
contained in the SmartGroup will be displayed in the File List for
your use. The SmartGroups Organizer is an easy way for
individuals and workgroups to logically group drawings and
documents together for easy, fast retrieval. This is a great way to
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store and share references to files that you use often or those that
pertain to a specific task or project.
Preview Tab
FastLook allows the user to create a database of thumbnail images
for the files in a folder. These thumbnails may be selected, viewed
and printed. This database is kept locally for the user in the Preview
sub-folder of the FastLook settings folder. Once a folder has been
cataloged, it will display the thumbnails in the Preview Tab.
Views Tab
If the drawing you are viewing contains layouts, sheets and/or
stored views, this tab will present the names of the views in a
treelike structure. You can easily change to another view by double-
clicking on the name.
Layers Tab
If the drawing you are viewing contains layers or levels, the Layers
Tab will present the list of layers and denote the layer's color and
its status as either on or off. All of these attributes can be changed
from the tab. In addition, default layer configurations can be
created, accessed and edited from the tab.

Viewing Files
If you wish to view one drawing or a number of drawings at once,
FastLook is a real time saver. To view a single file, use the Navigation
Panel to navigate to your drawings folder and double-click on the
filename. Change the file type mask by using the link at the top of the
panel.
To view multiple files, simply highlight the filenames in the File List, then
either press the View button; choose View from the context menu; or
press the Enter key. The images will be automatically opened in separate
windows. To automatically tile the new windows, select the Auto-Tile New
Windows option under the Options menu.



12

Zooming & Mouse Action
One feature of FastLook that will really spoil you is the automatic zoom
window. When FastLook is not in Select Entity Mode, the zoom is always
active. All you need to do is press and drag the left mouse button to
outline the zoom window. When you release the mouse button, FastLook
will zoom to the area you have specified. Zooming is also accomplished
using the mouse wheel.
When FastLook is in standard view mode, clicking the right mouse button,
while the cursor is over the drawing window, will cause FastLook to take
a user defined action. There are three options to choose, including a pop-
up menu, a single command or no action. You may redefine this action
under the Right Click Action section of the General tab in the Options
dialog.
Basic Viewing Functions
The basic viewing functions for manipulating the image are accessed
under the Display menu. These functions include various zoom
commands, pan, image rotation, contrast, Monochrome Vector, Invert
B&W, Change Page (for Multi-page TIFF), layer, stored views and 3D
viewpoint manipulation, and redraw. FastLook views many different
image types and not all of these functions are applicable to all images.
Please refer to Help for details on how to use each of these functions.
Redlining
The redline, or markup, feature allows you to communicate your ideas by
providing a means in which to draw annotations, corrections and
instructions on drawings. FastLook saves the redlining entities you create
in a separate file, always protecting the original. This file is automatically
opened and overlaid when you view a drawing with redlining turned on.
You can later export a redline file to the same file type as the one you are
redlining.
If you wish to set redline file preferences for all your redlining files,
access the Global Redlining Defaults dialog box from Options/Redlining.
Refer to Help for a detailed explanation.
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OverLook Window
OverLook is an extremely powerful tool for assisting in the viewing of
large CAD and scanned drawings. Zoom either in the main window or the
OverLook Window and a reticle appears in the OverLook. This reticle
represents the current zoom state of the main window in relation to the
entire drawing.
Send Mail
Drawings and related files can be easily emailed from FastLook to a co-
worker. Your mail service must be MAPI compliant. FastLook will allow
you to set defaults and to select what files to attach.
Compare Drawings
FastLook has the ability to easily compare two revisions of any AutoCAD
.DWG, Intergraph/MicroStation .DGN, HPGL or DXF drawing files. The
drawings being compared must have the same extents. FastLook will
display the results of the compare in a separate compare window.
Printing
FastLook uses your standard Windows printer drivers when printing or
plotting. FastLook has the capability to print a batch of drawings from a
single directory. Also, FastLook gives you the ability to affect the printing
of Line Widths. You may even use your AutoCAD PCP and CTB files.
Printing options may be set under the Options Dialog. Text Stamping
allows you to print date, time and text on your printed output. Refer to
Help for more details on printing options.

Measure
FastLook provides the ability to measure distances and areas on many
graphical formats. These Measure commands are found under the Info
menu. The ability to calibrate the Measure units has been provided
specifically for raster formats.

HyperLinking
This very powerful feature allows you to associate almost anything to "hot
spots" on an image. Linking can be used to create custom applications
like tying detail drawings to an assembly drawing, photos, other CAD
drawings or supporting documents. Your users can access all the
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documents and drawings relevant to a process or project, simply by
clicking an area on the computer screen. "Hot spots" may be associated
with documents, drawings, images, text files, other applications, internet
sites and even send commands to FastLook.

Information from AutoCAD drawings
FastLook has the ability to retrieve Extended Entity Data, Block
Attributes, Object Data and SQL links which are stored in an AutoCAD
drawing. From the Info menu, put FastLook in the entity pick mode that
corresponds to the type of data you wish to retrieve. Simply pick an entity
on the screen and FastLook will display the data. If you integrate
FastLook with an external application, such as Visual Basic, FastLook will
pass this data to your application for further processing. Contact Kamel
Software for more information on this powerful feature.

Auto-Run Feature
To increase the initial response time, FastLook can be configured to run
in the background at start-up. You can turn this feature on in the General
Tab of the Options dialog. Using this feature does not use a license until
you view a drawing.

Standby Mode
Standby Mode is another feature used to increase response time. After
FastLook is exited, the program will sleep in the background until needed.
When in this mode, the program can be accessed out of the system tray.
No license is used when FastLook is in Standby Mode.
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Technical Support
All technical support must be done through the Report-a-Problem feature
located under the Help menu. Please use this feature to access your
Priority Maintenance subscription to update your FastLook.

Kamel Software, Inc.
1809 E. Broadway St, Suite 134

Oviedo, FL  32765
Phone (407)672-0202

Fax (407)672-0416
www.kamelsoftware.com
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